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BAB III 

METODE DAN DESAIN PENELITIAN 

 

A. Metode Penelitian 

Dalam suatu penelitian perlu menetapkan suatu metode yang sesuai dan 

dapat membantu mengungkapkan suatu permasalahan yang dikaji. Keberhasilan 

dalam penelitian ilmiah tidak akan lepas dari metode yang digunakan dalam 

penelitian tersebut. Masalah yang akan diteliti serta tujuan yang ingin dicapai 

dalam suatu penelitian akan menentukan penggunaan metode penelitian 

eksperimen. Arikunto (1993, hlm. 3) menjelaskan bahwa: 

Metode eksperimen adalah suatu cara untuk mencari hubungan sebab 

akibat (hubungan kasual) antara dua faktor yang sengaja ditimbulkan oleh peneliti 

dengan mengurangi atau menyisihkan faktor-faktor yang bisa menggangu. 

Eksperimen selalu dilakukan dengan maksud untuk melihat akibat dari suatu 

perlakuan. 

Menurut Surakhmad (1980, hlm. 149) menyatakan ”Eksperimen adalah 

mengadakan kegiatan percobaan untuk melihat suatu hasil. Hasil itu yang akan 

menegaskan bagaimanakah kedudukan perhubungan kasual antara variable-

variabel yang diselidiki.” Tujuan bereksperimen bukanlah pada pengumpulan 

deskripsi data melainkan pada penemuan faktor penyebab dan faktor akibat. 

Mengenai penelitian eksperimen ini Sugiono (2009:73) membaginya ke dalam 3 

jenis yaitu “Pre Experimental Design, Quasi Experimental Design dan True 

Experimental Design”. 

Adapun jenis penelitian eksperimen yang digunakan penulis dalam 

penelitian ini adalah True Experiment. Maksum (2012, hlm. 65) “Peneitian 

eksperimen adalah penelitian yang dilakukan secara ketat untuk mengetahui 

hubungan sebab akibat di antara variabel.” Salah satu ciri utama dari penelitian 

eksperimen adalah adanya perlakuan (treatment) yang dikenakan kepada subjek 

atau objek penelitian. Dalam penelitian eksperimen, seorang peneliti sejauh 

mungkin harus dapat memastikan bahwa variasi atau perubahan yang terjadi pada 
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variabel bebas. Hal inilah yang kemudia disebut validitas internal. Dalam kaitan 

ini, mekanisme kontrol menjadi sesuatu yang sangat penting. 

Desain penelitian yang digunakan adalah Factorial Design 2x2 posttest 

only control group, untuk lebih jelasnya dapat dilihat pada tabel 3.1 di bawah ini;  

Tabel 3.1 

Desain Penelitian 

        Gross Motor Skill 

  

Model Pembelajaan 

Tinggi (B1) 

 

Rendah (B2) 

 

Pembelajaran Taktis/ 
Teaching Games for Understanding 

(TGfU)  A1 

A1B1 A2B1 

Pembelajaran Langsung/ 

Direct Instruction (DI) 

A2 

A1B2 A2B2 

 

Keterangan: 

A = Model Pembelajaran  

A1 = Model Pembelajaran Taktis/Teaching Games for Understanding 

   (TGfU) 

A2 = Model Pembelajaran Langsung/Direct Instruction (DI)  

B = Gross Motor Skill (GMS) 

B1 = Gross Motor Skill Tinggi 

B2 = Gross Motor Skill Rendah 

A1B1 = Perlakuan atau treatment berupa model pembelajaran Taktis/ 

Teaching Games for Understanding (TGfU) kelompok Gross 

Motor     Skill tinggi  

A2B1 = Perlakuan atau treatment berupa model pembelajaran langsun 

    (Direct Instruction) kelompok Gross Motor Skill tinggi 

A1B2 = Perlakuan atau treatment berupa model pembelajaran Taktis/ 

Teaching Games for Understanding (TGfU) kelompok Gross 

Motor   Skill rendah 

A2B2 = Perlakuan atau treatment berupa model pembelajaran langsung 

                (Direct Instruction) kelompok Gross Motor Skill rendah 
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Adapun langkah-langkah penelitiannya dapat dideskripsikan pada gambar 3.1 di  

bawah ini; 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

      Gambar 3.1 

    Langkah-langkah Penelitian 

Treatment Kelompok  TGfU (A1) 

 

A1B1. kelompok Gross Motor Skill tinggi 

A1B2. kelompok Gross Motor Skill tinggi 

Treatment Kelompok  DI (A2) 

 

A2B1. kelompok Gross Motor Skill tinggi 

A2B2. kelompok Gross Motor Skill tinggi 
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Perlakuan atau eksperimen dalam penelitian ini dilakukan sebanyak 16 

kali pertemuan. Pembelajaran dilaksanakan empat kali dalam seminggu yaitu 

Senin, Selasa, Rabu, dan Kamis dengan durasi waktu 45 menit pembelajaran 15 

menit pemasangan Polar FT 7. Kelompok model pembelajaran TGfU 

melaksanakan pembelajaran pada pukul 08.00 – 09.00 WIB, Sedangkan kelompok 

model pembelajaran direct instructional pukul 09.00 – 10.00 WIB. Hal ini 

berdasarkan pendapat Tarigan (2009, hlm. 17) menyatakan bahwa; 

“Agar pendidikan jasmani dan olahraga memberikan dampak yang 

positif pada anak sekolah maka dapat diterapkan rumusan FITT yang 

berarti: F = Frekuensi latihan/aktivitas 3-5 kali/minggu; I = Intensitas ringan 

dan sedang dalam zona denyut nadi latihan (Target Heart Rate) : 50% - 

70% x (220 - Usia); T = Time, waktu lamanya melakukan aktivitas fisik 

yaitu 30 – 60 menit; T = Type, yaitu tipe jenis olahraga yang dilakukan 

bersifat aerobik.” 

Terkait pemberian treatmen di atas, hal tersebut  telah disepakati oleh 

pihak sekolah dan peneliti. Waktu Pelaksanaan mulai tanggal 04 Agustus – 17 

September 2015, dapat dilihat pada lampiran 1. Bertempat di SD Laboratorium 

Percontohan UPI Jl.Setiabudhi no.229. 

 

B. Lokasi dan Subjek Penelitian 

1. Lokasi penelitian 

Penelitian ini dilaksanakan di sekolah dasar LabSchool Percontohan UPI, 

Kota Bandung. Jl.Setiabudhi No.229, yang menjadi sampel atau subjek 

penelitiannya adalah siswa sekolah dasar kelas tiga. Dalam sebuah penelitian, 

diperlukan proses mengumpulkan data sampai dengan menganalisis data sehingga 

mendapatkan gambaran yang sesuai dengan apa yang diharapkan dalam penelitian 

ini maka diperlukanlah sumber data. Pada umumnya sumber data dalam penelitian 

disebut populasi dan sampel penelitian. 

2. Populasi  

Populasi merupakan sekelompok objek yang dapat dijadikan sumber 

penelitian berbentuk benda-benda, manusia ataupun yang terjadi sebagai 

objek/sasaran penelitian. Sugiyono (2009, hlm. 80), berpendapat bahwa “populasi 

adalah wilayah generalisasi yang terdiri dari objek atau subjek yang menjadi 
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kuantitas dan karakteristik tertentu yang ditetapkan oleh penelitian untuk 

dipelajari dan kemudian ditarik kesimpulan. Populasi dalam penelitian ini adalah 

siswa kelas tiga SD laboratorium percontohan UPI yang terdiri dari tiga kelas, 

masing-masing kelas berjumlah 25 siswa sehingga jumlah keseluruhan populasi 

75 siswa. Dalam menetapkan SD laboratorium Percontohan UPI sebagai populasi 

penelitian, setidaknya mengacu kepada beberapa alasan, antara lain: (1) SD 

Laboratorium percontohan UPI merupakan sekolah laboratorium bagi Universitas 

Pendidikan Indonesia, dimana sekolah tersebut memiliki misi mengembangkan 

dan mengimplementasikan inovasi pendidikan dalam berbagai bidang studi 

(sd.labschool.upi.edu, 2014); (2) Siswa kelas tiga SD berusia antara 7-9 tahun, 

sehingga cocok dengan penelitian yang akan dilakukan; (3) Siswa SD 

percontohan UPI memiliki latar belakang agama, status sosial ekonomi, dan 

budaya yang berbeda-beda, sehingga diharapkan dapat mencerminkan 

kebanyakan SD di Indonesia.  

3. Sampel 

Sampel adalah sebagian atau wakil populasi yang diteliti. Berkaitan 

dengan ini, Sugiyono (2009, hlm. 81) mengemukakan bahwa “sampel adalah 

bagian dari jumlah dan karakteristik yang dimiliki oleh populasi tersebut”. 

Selanjutnya, Maksum (2012, hlm. 60) menegaskan bahwa “kriteria sampel 

ditentukan oleh peneliti sendiri sesuai dengan tujuan penelitian”. 

Dasar pertimbangan pemilihan sampel yang diteliti adalah siswa Sekolah 

Dasar kelas tiga yaitu mereka dianggap baik dalam perspektif psikomotor maupun 

kognitif, sehingga mampu mengikuti program pembelajaran. Selanjutnya, teknik 

cluster random sampling digunakan untuk menentukan kelompok kelas mana 

yang akan menjadi kelompok eksperimen dan yang akan menjadi kelompok 

kontrol. 

Pengambilan sampel dalam penelitian ini menggunakan teknik Cluster 

Random Sampling, menurut Suharsimi Arikunto (2002, hlm. 199) teknik ini 

adalah tidak langsung memilih individu mana yang akan diteliti, tetapi memilih 

kelompok (cluster) yang termasuk dari anggota sampel, yaitu anggota yang 

berada dalam kelompok yang dipilih. Jadi, sampel yang dipilih bukan dalam 
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sekala individu melainkan kelompok atau area yang kemudian disebut  cluster. 

Selanjutnya Populasi yang berjumlah 75 orang yaitu siswa kelas tiga SD 

laboratorium percontohan UPI yang terdiri dari tiga kelas, selanjutnya dipilih 

secara acak dua kelas yang kemudian diberikan TGMD 2, tujuannya untuk 

mengetahui gross motor skills siswa. Dari hasil TGMD 2, kemudian peneliti 

mengambil beberapa orang siswa untuk dijadikan sampel penelitian dari masing-

masing tingkat gross motor skills, yaitu gross motor skills tinggi dan Gross Motor 

Skills rendah. Direngking dari nilai tertinggi samapi nilai terendah. Dalam 

penentuan jumlah sampel, peneliti mengacu pada pendapat yang dikemukakan 

oleh Verducci (1980, hlm. 176), yaitu  “27 % kelas atas dan 27 % kelas bawah”.  

Dari pendapat di atas, maka jumlah sampel yang digunakan dalam 

penelitian ini hanya 20 orang siswa yang berada pada rangking 10 teratas 

termasuk kategoti gross motor skills tinggi, dan rangking  10 terendah termasuk 

dalam kategori gross motor skills rendah, yang selanjutnya masing – masing 

kategori dibagi menjadi dua, yaitu masing – masing lima orang pada sel gross 

motor skills tinggi dan rendah untuk pembelajaran TGfU, dan masing – masing 

lima orang pada sel gross motor skills tinggi dan rendah untuk pembelajaran DI, 

dari keseluruhan siswa kelas tiga SD laboratorium percontohan UPI. 

Pembagian kelompok dengan cara ini akan lebih objektif bagi semua 

subjek penelitian, hal ini didasarkan atas kesempatan yang sama bagi semua 

subjek penelitian untuk masuk ke dalam tiap kelompok. Setelah terbagi menjadi 

empat kelompok (dua kelompok dalam kelas eksperimen dan dua kelompok 

dalam kelas kontrol), selanjutnya akan diberi perlakuan/treatment yaitu dengan 

menerapkan model pembelajaran TGfU untuk kelompok kelas eksperimen dan 

Direct Instruction untuk kelompok kelas kontrol dengan materi pembelajaran 

berbagai kombinasi gerak dasar melalui permainan sederhana. 
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C. Definisi Operasional 

1. Model pembelajaran menurut Joice, Weil, and Calhoun (2000, hlm. 6) adalah 

sebagai berikut: 

A model of teaching is a description of a learning environment. The 

description have many use, ranging from planning curriculums, 

course, unit, and lessons to designing instructional material-books 

and workbooks, multimedia program, and computers-assisted 

learning problem. 

Maksud dari kutipan di atas yaitu, model pembelajaran merupakan 

deskripsi dari lingkungan belajar yang menggambarkan perencanaan kurikulum, 

kursus-kursus, desain unit-unit pembelajaran, perlengkapan belajar, buku-buku 

pelajaran, buku-buku kerja, program multimedia, dan bantuan belajar melalui 

komputer. 

2. Model pembelajaran taktis (TGfU), model pembelajaran yang menggunakan 

pemecahan taktik dalam games dengan runtutan pembelajaran games teach 

games dalam (Metzler 2000, hlm. 342)  

3. Model pembelajaran langsung (Direct Instruction), dicirikan sebagai 

keputusan berpusat pada guru atau memakai bentuk arahan guru ke siswa 

Metzler 2000, hlm. 162) dengan aturan pembelajaran Warm-up, Technique 

drills, Games, Warm down. 

4. intensitas aktivitas fisik adalah usaha sadar yang dilakukan oleh manusia 

berkaitan kerja fisik yang menyangkut sistem lokomotor tubuh yang 

ditujukan dalam menjalankan aktifitas tubuh sehari-hari dengan dosis atau 

takaran tertentu. Secara sederhana adalah usaha sadar manusia untuk 

mencapai kemandirian fisik dengan dosis atau takaran. 

 

D. Instrumen Penelitian 

Sebagai upaya untuk mendapatkan data dan informasi yang lengkap 

mengenai hal-hal yang ingin dikaji melalui penelitian ini, maka dibuatlah 

seperangkat instrumen yang akan digunakan pada penelitian ini. Instrumen yang 

akan digunakan dalam penelitian ini adalah tes. Tes digunakan untuk mengukur 
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aspek pemahaman dan gross motor skills siswa dalam menyikapi treatmen yang 

akan diberikan. 

Instrument tes. Menurut Arikunto (2006:150) “Tes adalah serentetan 

pertanyaan atau latihan serta alat lain yang digunakan untuk mengukur 

keterampilan, pengetahuan intelegensi, kemampuan atau bekal yang dimiliki oleh 

individu atau kelompok.” Tes digunakan untuk mengukur keterampilan gerak 

dasar seperti ketangkasan, reaksi, kelincahan, keseimbangan, dan kecepatan. 

Bentuk tes yang digunakan dalam penelitian ini adalah Polar FT 7 dan TGMD 2, 

adapun administrasi tesnya dijelaskan dalam halaman berikut; 

1. Polar FT 7  

Polar FT 7 adalah sistem serbaguna yang memungkinkan untuk 

merencanakan, memonitor aktivitas fisik, dan menganalisis data. Pemantauan 

aktivitas didasarkan pada gerakan tubuh yang terhubung secara otomatis langsung 

termonitor. Adapun spesifikasi Polar FT 7 yaitu; sport watch, heart monitor, 

calories burned, water resistant, lebih lanjut perangkat Polar FT 7 diantaranya; 

a. Isi dalam box: 1) Polar FT 7 training computer, 2) Polar 

WireLink+transmitter, 3) Buku panduan. 

b. Fitur diantaranya: pengukur tubuh (HR maksimal dan HR rata-rata, 

HR  target latihan, indikator energi yang dikeluarkan/calori, waktu 

aktivitas), data transfer, fitur perekam (total data latihan, penyimpanan 

data latihan sampai 99, riwayat latihan per minggu), fitur latihan 

(grafik indikator target latihan, unit tombol operasi untuk latihan), fitur 

jam tangan (lampu penerang, indikator tanggal dan hari latihan, 

display text dalam bahasa inggris, jerman, finlandia, swedia, portugal, 

spanyol, dan itali, zona dua waktu, indikator batre lemah, waktu dalam 

12/24 dengan alarem dan sinyal getar, tahan air 30 m). Tampilan dapat 

dilihat pada gambar 3.2 di halaman selanjutnya. 
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Gambar 3.2 

Polar FT 7 

Dalam hal ini Polar FT 7 digunakan untuk mengukur intensitas aktivitas 

fisik yang dikaitkan dengan Heart rate,  sebagai indikator dari aktivitas fisik yang 

telah dilakukan. Disampaikan Giriwijoyo (2009, hlm.55) “Denyut nadi 

merupakan indikator untuk melihat intensitas olahraga/ kerja yang sedang 

dilakukan”. Yaitu dengan dosis 65% – 80% dari denyut nadi maksimal (DNM), 

yang di dapat dari rumus 220 – usia. Sebagai contoh peserta dengan usia 8 tahun 

maka, 220 – 8 = 212, kemudian dikalikan 65% sebagai batas bawah intensitas 

aktivitas fisik didapat nilai 137 bpm, dan untuk batas atas intensitas aktivitas fisik 

212 dilakikan 80% didapat nilai 169 bpm. Adapun akurasi calori, feat burn and 

fitness zon, adalah prodak dari intensitas aktivitas fisik yang dilakukan dengan 

catatan heart rate yang telah dicapai, pada penelitain kali ini report heart rate 

yang akan disajikan diantaranya heart rate pada saat pemanasan, heart rate rata-

rata dan heart rate maksimal, dalam kesempatan ini yang akan dijadikan sebagai 

indikator intensitas aktivitas fisik adalah heart rate rata-rata atau average heart 

rate. 

Seperti yang telah dijelaskan di atas, Polar FT 7 terdiri dari perangkat 

keras dan perangkat lunak, perangkat keras diantaranya: 1) Jam tangan, sebagai 

alat untuk memasukan data pengguna, sekaligus sebagai alat untuk melihat hasil 

dari aktivitas yang telah digunakan, dapat di lihat pada gambar 3.3 di halaman 

selanjutnya. 
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Gambar 3.3 

Jam Tangan, Strap Chest dan Dongle 

 

2) Strap Chest, berfungsi untuk mengikat doundge tepat di dada; 3) Doundge, 

adalah alat yang berfungsi sebagai sinyal monitor heart rate yang terhubung 

langsung dengan jam tangan yang sedang digunakan. 

 

Gambar 3.4 

Penggunaan dan Pemasangan Strap Chest dan Doundg. 

 

Ada pun cara penggunaan polar FT 7, sebagai berikut: 

a. Masukkan data pengguna ke dalam jam tangan diantaranya: tanggal 

lahir, berat badan, tinggi badan dan jenis kelamin. 

b. Gunakan strap chest tepat di dada bagian bawah, yang sebelumnya 

sudah terpasang dengan doundg. 

c. Gunakan jam tangan yang terlebih dahulu diset dengan data pengguna. 

d. Setelah semua siap tekan tombol start pada jam tangan dan secara 

simultan heart rate selama aktivitas akan termonitor pada jam tangan. 
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2. TGMD 2 

Dalam penelitian ini instrumen yang digunakan untuk mengukur 

keterampilan motorik kasar anak adalah Test Gross Motor Development – Second 

Edition (TGMD-2nd Edition). (Ulrich, 2000). Struktur dan item tes digambarkan 

melalui tabel 3.2 di bawah ini. 

Tabel 3.2 

Struktur Item Tes TGMD-2 

Subtes Skill 
∑ Kriteria 

Performance 

Skor 

Maksimal 

Locomotor 

Run 4 8 

Gallop 4 8 

Hop 5 10 

Leap 3 6 

Jump 4 8 

Slide 4 8 

Object Control 

Strike 5 10 

Dribble 4 8 

Catch 3 6 

Kick 4 8 

Throw 3 6 

Roll 4 8 

 

Ters ini mencakup 12 tes gerak dikategorikan menjadi dua subvariabel 

Locomotor (run, gallop, hop, leap, horizontal jump, slide) dan Object Control 

(striking a stationary dribble, catch kick, overhand throw and underhand roll). 

Masing – masing keterampilan dilakukan dua kali dengan kriteria penampilan 

yang telah ditetapkan, untuk subtes performance record dapat dilihat pada 

lampiran empat, dan  pedoman instruksi penilaian dapat dilihat pada lampiran 

tiga. Tes ini digunakan segai tes awal, hanya untuk menentukan kelas eksperimen 

dan kelas kontrol yang masing - masing kelas tebagi menjadi dua sel yaitu, gross 

motor skills tinggi dan gross motor skills rendah. 
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a. Validitas Instrumen 

TGMD-2 telah diuji validitas terhadap 1. 208 ana di Amerika (Ulrich, 

2000 dalam Wong and Choeung, 2010:203). Pengujian dengan teknik 

explanatory factor analisys (EFA) dan confirmatory factor analysis 

(CFA). Hasil dari CFA di Amaerika adalah berupa nilau kesesuaian, 

yakni goodness-os-fit index (GFI) sebesar 0,96 dan adjusted GFI (AGFI) 

sebesar 0,95. Kemudian TGMD-2 diuji kembali validitasnya di Hongong 

oleh Wong and Cheung (2010) kepada 614 anak. Hasilnya GFI sebesar 

0,95, root mean square error of approximation = .06, standardized root 

mean square residual = .04, comparative-fit index = .97). The findings of 

this study suggested that the two-factor structure proposed by Ulrich 

(2000) fir the data of Hong Kong Chinese children (Wong and Cheung, 

2010). 

 

b. Reabilitas Instrumen 

TGMD-2 memiliki reabilitas tinggi dengan keofisien reabilitas 

subvariabel locomotor dan object control masing-masing 0,91, 0,85, dan 

0,88 gabungan (Ulrich 2000 dalan Chow dan Chan, 2011:73). 

 

E. Teknik Pengumpulan Data 

Teknik pengumpulan data yang akan dilakukan dalam penelitian ini harus 

dilakukan dengan tepat, sehingga benar-benar di dapat data valid dan relevan.  

Teknik pengumpulan data dalam penelitian ini terdiri dari tiga langkah, yakni 

pretest, treatment, dan posttest. 

1. Pretest 

  Dalam penelitian ini, sebelum diberikan perlakuan/treatment siswa di tes 

gross motor skills untuk membedakan dan membagi kelompok antara siswa yang 

memiliki gross motorik skills tinggi dengan siswa yang memiliki gross motorik 

skills rendah. 

Jenis tes gross motorik skills yang digunakan dalam penelitian ini adalah 

Test Gross Motor Development – Second Edition (TGMD-2nd Edition). (Ulrich, 
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2000). Tes ini mencakup 12 tes gerak di kategorikan menjadi dua subvariable 

Locomotor (run, gallop, hop, leap, horizontal jump, slide) dan Object Control 

(striking a stationary dribble, catch kick, overhand throw and underhand roll). 

2. Treatment 

Treatment/perlakuan yang diberikan dalam penelitian ini ialah dengan 

menerapkan model pembelajaran TGfU kepada kelompok eksperimen dan model 

pembelajaran DI kepada kelompok kontrol. 

3. Posttest 

 Pelaksanaan posttest / tes akhir dilakukan setelah pemberian treatment / 

perlakuan kepada kelompok eksperimen dan kelompok kontrol untuk dilihat hasil 

belajarnya dengan menggunakan instrumen penelitian Polar FT 7. Pengambilan 

data dilakukan setiap empat kali pertemuan,  dari 16 kali pertemuan data diambil 

sebanyak empat kali, yaitu pada tanggal 27 Agustus  2015, kemudian tanggal 3, 

10, dan 17 Seprember 2015. 

 

F. Teknik Analisis Data 

Data hasil monitoring aktivitas fisik sampel yang sudah terkumpul 

kemudian dianalisis dengan menggunakan teknik analisis statistik. Teknik analisis 

statistik ini dilakukan dengan menggunakan uji normalitas dan uji homogenitas. 

Tujuan dilakukannya uji normalitas untuk mendapatkan distribusi data sebagai 

acuan untuk uji statistik selanjutnya, yakni apakah sampel yang diambil dari 

populasi berdistribusi normal serta untuk menentukan uji statistik selanjutnya 

dengan catatan bila data berdistribusi normal maka menggunakan uji statistik 

parametrik dan bila data tidak berdistribusi normal maka menggunakan uji 

statistik non parametrik. Uji normalitas ini dilakukan terhadap data post test 

menggunakan data skor selisih dengan uji kolmogorov-smirnov. Selanjutnya uji 

homogenitas dengan menggunakan levene statistic dimaksudkan untuk menguji 

dua kelompok atau lebih data sampel dari populasi apakah memiliki variansi yang 

sama. Uji korelasi digunakan untuk menguji apakah hipotesis ini yang diajukan 

diterima atau tidak. 
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Setelah data intensitas aktivitas fisik terkumpul, langkah selanjutnya 

adalah mengolah dan menganalisis data tersebut menggunakan program Software 

Computer Statistical Product and Service Solution (SPSS) Serie. 22. Langkah-

langkah pengolahan dan analisis data adalah sebagai berikut: 

1. Deskripsi Data 

Untuk pengdeskripsian data penulis melakukan pengolahaan dengan 

mencari rata-rata, simpangan baku/ standar deviasi, varians. Tahap 

penghitungan SPSS ini dengan langkah-langkah sebagai berikut: klik Analyze 

> Descriptive Statistics > Descriptives > Masukan semua variabel ke kotak 

Variable(s) > Options > ceklis Mean, Std. Deviation, dan Variance > Continue 

> OK 

2. Uji Normalitas 

Menguji normalitas data dari setiap data, untuk mengetahui apakah data 

tersebut berdistribusi normal atau baik. Uji normalitas menggunakan 

kolmogorov-smirnov, tahap penghitungan SPSS ini dengan langkah-langkah 

sebagai berikut: klik Analyze > Nonparametric Tests > Legacy Dialogs > 1-

Sample K-S > Masukan semua variabel ke kotak Test Variable List > OK. 

Format pengujiannya dengan membandingkan nilai probabilitas (p) atau 

signifikansi (Sig.) dengan derajat kebebasan (dk) α = 0,05. Uji 

kebermaknaannya sebagai berikut: 

a. Jika nilai Sig. atau P-value > 0,05 maka data dinyatakan normal. 

b. Jika nilai Sig. atau P-value < 0,05 maka data dinyatakan tidak normal. 

3. Uji Homogenitas 

Uji homogenitas dilakukan untuk mengetahui apakah data memiliki 

varians yang sama atau tidak, artinya apakah data berasal dari satu populasi 

yang sama atau tidak. Uji homogenitas menggunakan levene statistic, tahap 

penghitungan SPSS ini dengan langkah-langkah sebagai berikut: klik Analyze 

> Compare Means > One-Way ANAVA> Masukan semua variabel X ke 

kotak Dependen List dan K ke kotak Factor > Options > ceklis Homogeneity 

of variance test > Continue > OK. Format pengujiannya dengan 
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membandingkan nilai probabilitas (p) atau signifikansi (Sig.) dengan derajat 

kebebasan (dk) α = 0,05. Uji kebermaknaannya sebagai berikut: 

a. Jika nilai Sig. atau P-value > 0,05 maka data dinyatakan homogen. 

b. Jika nilai Sig. atau P-value < 0,05 maka data dinyatakan tidak 

homogen. 

4. Uji Anava Dua Jalur 

Uji korelasi digunakan untuk menguji apakah hipotesis ini yang diajukan 

diterima atau tidak. Pengujian hipotesis ini menggunakan taraf signifikansi 5 

% dari 100 % atau kebenaran yang dicapai 95%, tahap penghitungan SPSS ini 

dengan langkah-langkah sebagai berikut: klik Analyze > Correlate > Bivariate 

> Masukan semua variabel 1 ke kotak Dependent Variabel dan variabel 2 dan 

3 ke kotak Fixed Factor(s) > Plots > masukan variabel 2 ke kotak Horizontal 

Axis dan variabel 3 kotak Separate Lines > Add > Continue > Post Hoc > 

masukan semua variabel ke kotak Post Hoc Tests for > ceklis Tukey > 

Continue > OK. Format pengujiannya dengan membandingkan nilai 

probabilitas (p) atau signifikansi (Sig.) dengan derajat kebebasan (dk) α = 

0,05. Uji kebermaknaannya sebagai berikut: 

a. Jika nilai Sig. atau P-value > 0,05 maka data dinyatakan signifikan. 

b. Jika nilai Sig. atau P-value < 0,05 maka data dinyatakan tidak 

signifikan.  
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G. Hipotesis Statistik 

Dalam prosedur penelitian harus dirumuskan berdasarkan hipotesis 

statistik sebagai berikut: 

1. H0 : µ A1 = µ A2 

H1 : µ A1 ≠ µ A2 

2. H0 : Interaksi A X B = 0 

H1 : Interaksi A X B ≠ 0 

a. H0 : µ A1B1 ≤ µ A2B1 

H1 : µ A1B1 > µ A2B1 

b. H0 : µ A1B2 ≤ µ A2B2 

H1 : µ A1B1 > µ A2B2 

 

Keterangan: 

µ = Nilai Rata - rata 

A1 = Model Pembelajaran Taktis/Teaching Games for Understanding 

   (TGfU) 

A2 = Model Pembelajaran Langsung/Direct Instruction (DI)  

B1 = Gross Motor Skill Tinggi 

B2 = Gross Motor Skill Rendah 

 


